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SUMMARY

Quantitative assessment of post-ischemic cardiac remodeling is often hampered
by tissue complexity and structural heterogeneity of the scar. Automated quan-
tification of microscopy images offers an unbiased approach to reduce inter-
observer variability. Here, we present a CellProfiler-based analytical pipeline
for the high-throughput analysis of confocal images to quantify post-ischemic
cardiac parameters. We describe image preprocessing and the quantification
of capillary rarefaction, immune cell infiltration, cell death, and proliferating fi-
broblasts. This protocol can be adapted to other tissue types.
For complete details on the use and execution of this profile, please refer to Jan-
bandhu et al. (2021).
BEFORE YOU BEGIN

We outline an image analysis protocol for the automated analysis of post-ischemic cardiac param-

eters, using freely available software, Fiji (Schindelin et al., 2012) and CellProfiler (Carpenter

et al., 2006; McQuin et al., 2018) (key resources table). These two open-source software are highly

complementary when used in tandem for image-processing and segmentation, as well as for many

other bioimage analysis needs (Dobson et al., 2021). No programming knowledge is necessary to

run Fiji Macros or CellProfiler pipelines (key resources table), so this protocol is highly accessible.

Theoretically, there is no limit to the numbers of images that can be analyzed using this approach,

the limiting factor here is computational power. It is feasible that, using high-performance

computing, tens of thousands of images could be analyzed for high throughput bioimage analysis,

by calling these pipelines with the command line. There are 4 CellProfiler pipelines and image sets

used here for the analysis of: 1) cardiomyocyte (CMs) hypertrophy and vascularization; 2) inflamma-

tion; 3) cardiac fibroblast (CF) proliferation and 4) apoptosis. The acquisition of high-quality 2D

confocal images is necessary for accurate use of this pipeline, and is, as such, assumed. Details of

tissue sectioning, staining and confocal microscopy are described in Janbandhu et al. (2021). The

fluorescently conjugated markers used in the study are detailed in Table 1. CFs and their progeny

were irreversibly tagged with tdTomato (TdT) using transgenic mouse models (genetic lineage-

tracing), and mice were injected with 5-ethynyl-20-deoxyuridine (EdU) 1 day before tissue collection

to identify proliferating CFs. CM boundaries were labeled with Wheat Germ Agglutinin (WGA) for
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Table 1. Staining markers and cardiac parameters

Staining markers Fluorophore(s) Label type
Cardiac
parameters

TUNEL Tetramethylrhodamine
(TMR) red

Chemical reagent Apoptosis

CD45 Cy7 Antibody Inflammation

tdTomato and 5-ethynyl-20-
deoxyuridine (EdU)

DsRed and
AlexaFluor 488

Transgenic marker and
chemical reagent

CFs and
proliferation

WGA (Wheat Germ Agglutinin) AlexaFluor 488 Conjugated glycoprotein label Hypertrophy

IB4 (Isolectin B4) AlexaFluor 568 Conjugated lectin Vascularization
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the assessment of hypertrophy and capillaries were labeled with Isolectin B4 (IB4). Nuclei of

apoptotic cells were detected by terminal deoxynucleotidyl transferase dUTP nick end labeling (TU-

NEL) assay. Lastly, immune cells were labeled using a fluorescently conjugated anti-CD45 antibody.

Note: (1) If reporter mice are not available, CFs can be immuno-labeled using anti-PDGFRa

antibody and visualized with appropriately labeled secondary antibody. (2) This protocol is

an image analysis protocol; the availability of appropriate confocal images is assumed. The

image acquisition was performed using a Zeiss LSM700 confocal microscope, and acquisition

parameters used for this work were as follows: 20x Plan Apochromat air objective, with Nu-

merical Aperture (NA) of 0.8; x/y resolution of 6.4 pixels/mm x/y size of 1024 pixels or

160.04 mm. And the timing for analysis is based on a Dual-Core Intel Core i5 processor with

8GB RAM, running macOS Catalina operation system. (3) This protocol was optimized for

use with confocal images; however, it is conceivable that it could be applied to widefield fluo-

rescent images, if they are of sufficiently high quality, with regards to signal-to-noise, intensity

and tissue background. If not, then additional deconvolution steps may be necessary prior to

analysis, with proprietary software such as Huygens.

CRITICAL: To ensure high-throughput image processing, all files should contain a unique
identifier, so they can be identified after processing and analysis e.g., Sample1_CD31_

2021.lsm, Sample1_CD45_2021.lsm.
KEY RESOURCES TABLE
REAGENT or RESOURCE SOURCE IDENTIFIER

Software

Fiji ImageJ v1.52p Schindelin et al. (2012)
(PMID: 22743772)

https://imagej.net/Fiji

CellProfiler v3.1.9 McQuin et al. (PMID: 29969450) https://cellprofiler.org/

Others

Macro #1: 1_Macro_pipeline1.ijm This paper https://github.com/VCCRI/
Cardiac-Image-Analysis.git

Macro #2: 2_ Macro_pipeline2.ijm This paper As above

Macro #3: 3_ Macro_pipeline3.ijm This paper As above

Macro #4: 4_ Macro_pipeline4.ijm This paper As above

Analysis pipeline #1 - Segment and
measure capillaries and cardiomyocytes:
1_Capillary_per_CM_segment.cpproj

This paper https://github.com/VCCRI/
Cardiac-Image-Analysis.git

Analysis pipeline #2 - Segment and
measure immune cells and cardiomyocytes:
2_CD45_per_CM_segment.cpproj

This paper As above

Analysis pipeline - Segment and measure
proliferating cells and fibroblasts:
3_Edu_FB_segment.cpproj

This paper As above

(Continued on next page)
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Continued

REAGENT or RESOURCE SOURCE IDENTIFIER

Analysis pipeline - Segment apoptotic
cells: 4_Tunel_segment.cpproj

This paper As above

4 x Image folders – contains sample
images (.lsm format) to run each of the
4 Macros and pipelines

This paper https://github.com/VCCRI/
Cardiac-Image-Analysis.git

Example Data folder – contains example
raw .csv file outputs, segmentation outputs
and annotated .xlsx file for pipeline #1 to
indicate relevant data for downstream analysis

This paper https://github.com/VCCRI/
Cardiac-Image-Analysis.git
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Note: The pipeline detailed below will work on the current versions of both CellProfiler

(v4.2.1) and Fiji (v1.53). However, if using a later version of CellProfiler, it may be necessary

to load the pipelines using the .cpipe file format, also found in the Github repository page,

as the .cproj files may not load effectively. The minimum version of CellProfiler required is

v3.0.
STEP-BY-STEP METHOD DETAILS

Image pre-processing

Timing: �25–30 s per file with Fiji

Multi-channel confocal/fluorescence microscopy images can be acquired using many different im-

aging platforms. Each platform will save image data and accompanying metadata with proprietary

file formats, which can be read into Fiji automatically, or using the Bio-Formats importer (Linkert

et al., 2010). Image pre-processing steps are essential for the accurate segmentation of objects,

such as nuclei, capillaries and immune cells. Each Fiji macro (key resources table) will run batch pro-

cesses on a single folder of images, to perform the following: Splitting individual channels, convert-

ing from 16-bit to 8-bit (for visualization purposes only), improving contrast and smoothing all im-

ages, and inverting WGA-stained CMs.

Note: Image pre-processing steps below are designed to be performed on the example im-

ages found in the VCCRI Github folder (link in the key resources table). Each macro will output

processed images into a new folder within the user-selected directory. If using on the user’s

own image sets, the directory structures may be different, and the running of Macros will

need to be adapted accordingly.

1. Download the VCCRI GitHub Cardiac-Image-Analysis repository, which contains all files listed in

the key resources table.

a. Click the green ‘‘Code’’ button on the main page.

b. Download the zip folder and move the uncompressed directory to the desired location.

2. Open Fiji and run macro #1 (1_Macro_pipeline1.ijm) on image folder 1 (1_Images_pipeline1_W-

GA_IB4). This macro splits and pre-processes images for pipeline #1.

a. Select ‘‘Plugins > Macro > Run.’’.

b. Select macro #1 in the first popup window, click Open.

c. Select the desired input folder, and in the second popup window, click Open.

d. Wait until the log states the conversion is complete, or the processing updates (in the bottom

left corner of the Fiji window) have stopped, before moving to the next step.

e. This will output a folder named ‘‘SplitChannel_1’’ into the selected input folder, which will be

used as the input for CellProfiler pipeline #1.

3. In Fiji, run macro #2 (2_Macro_pipeline2.ijm) on image folder 2 (2_Images_pipeline2_W-

GA_CD45). This macro splits and pre-processes images for pipeline #2.
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Figure 1. Home Screen View of Fiji Plugins drop-down menu

Fiji Plugins menu, with Macros and Run selected.
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a. Select ‘‘Plugins > Macro > Run.’’.

b. Select macro #2 in the first popup window, click Open.

c. Select the desired input folder, and in the second popup window, click Open.

d. Wait until the log states the conversion is complete, or the processing updates (in the bottom

left corner of the Fiji window) have stopped, before moving to the next step.

e. This will output a folder named ‘‘SplitChannel_2’’ into the selected input folder, which will be

used as the input for CellProfiler pipeline #2.

4. In Fiji, run macro #3 (3_Macro_pipeline3.ijm) on image folder 3 (3_Images_pipeline3_EdU+-

FBNo). This macro splits and pre-processes images for pipeline #3.

a. Select ‘‘Plugins > Macro > Run.’’.

b. Select macro #3 in the first popup window, click Open.

c. Select the desired input folder, and in the second popup window, click Open.

d. Wait until the log states the conversion is complete, or the processing updates (in the bottom

left corner of the Fiji window) have stopped, before moving to the next step.

e. This will output a folder named ‘‘SplitChannel_3’’ into the selected input folder, which will be

used as the input for CellProfiler pipeline #3.

5. In Fiji, run macro #4 (4_Macro_pipeline4.ijm) on image folder 4 (4_Images_pipeline4_TUNEL).

This macro splits and pre-processes images for pipeline #4.

a. Select ‘‘Plugins > Macro > Run.’’.

b. Select macro #4 in the first popup window, click Open.

c. Select the desired input folder, and in the second popup window, click Open.

d. Wait until the log states the conversion is complete, or the processing updates (in the bottom

left corner of the Fiji window) have stopped, before moving to the next step.

e. This will output a folder named ‘‘SplitChannel_4’’ into the selected input folder, which will be

used as the input for CellProfiler pipeline #4.

Note: We have described Macros for splitting confocal images with 3 channels in 2 different

orders (i.e., channel 1–3, representing, Green-Red-Blue or Blue-Green-Red, respectively). For

confocal images with more or less than 3 channels, channel numbers and order in all Macros

must be edited/updated in the Fiji macro editor to correctly split the images (by dragging the

macro file into Fiji or selecting ‘‘Plugins > Macros > Edit.’’ and selecting the desired Macro in

the popup window). The image-processing parameters for Macros may also need to be opti-

mized for the user’s own images, due to possible differences in image acquisition and image

quality. The intention of these Macros is to achieve images similar to those seen in Figure 2,

after pre-processing is complete.
4 STAR Protocols 3, 101097, March 18, 2022



Figure 2. Representative images before and after automated processing

(A) Nuclei labeled with DAPI before (i) and after (ii) automated pre-processing steps.

(B) Cardiomyocyte boundaries labeled with Wheat Germ Agglutinin (WGA) (i), and processed in two steps (ii-iii).

(C) Capillaries labeled with Isolectin B4 (IB4) before (i) and after (ii) processing. Scale bar represents 20mm.
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Analysis using CellProfiler

CellProfiler is capable of running complex image analysis pipelines on batches of several thousands

of images in only a fewminutes to hours. The software requires the use of analysis modules which run

image processing algorithms, threshold-based segmentation, calculations and file processing.

Below (Table 2), we outline the function of each module required for the segmentation of nuclei,

CMs, capillaries, proliferating CFs, apoptotic cells, and immune cells in 2D confocal images from

murine hearts. Table 3 can be consulted for troubleshooting problems with segmentation in CellPro-

filer. Pipelines optimized for three channels (Red, Green and Blue (RGB)) are listed in the key re-

sources table.

‘‘Settings’’ indicate how each module is used, while ‘‘Functions’’ outline what each module does in

the context of this protocol.
Pipeline #1 – Quantify number of capillaries per cardiomyocyte

Segmentation of nuclei

Timing: 10–15 min to set optimal parameters and �5–10 s to analyze each file with

CellProfiler

Segmentation, the delineation of objects in an image, is achieved here using a number of strategies

involving intensity thresholding, size thresholding, image masking and/or object relationships. The

accurate segmentation of objects in tissue sections (as compared to cells in culture) is challenging
STAR Protocols 3, 101097, March 18, 2022 5



Table 2. CellProfiler modules for cardiac tissue segmentation

Module Settings Function

Identify Primary Objects Global thresholding using
Adaptive, Otsu approach; based
on object size and intensity

Segment nuclei or whole cells (CMs and CFs)

Identify Secondary Objects Watershed - Gradient method across
the image; Adaptive, Otsu approach

Detect cell boundaries using object as seed,
using primary stain (e.g., center of CM)

Identify Tertiary Objects Subtraction Subtract 1� object from 2� object to give ‘cytosolic’ area

Expand or Shrink Objects Expand objects by 5 pixels Expand the masked area for CM image masking

Mask Image Select image to mask and invert the mask Remove the background/empty space from CM images

Smooth Smooth, keeping edges with
edge intensity diff. of 0.1

Clean the immune cell images before segmentation

Overlay Objects Select objects and image Overlay segmented objects on image of choice

Relate Objects Set parents (larger object) and children
(smaller) - Save

Determine children (EdU+ nuclei) that are
segmented within parents (TdT+ CFs)

Measure Colocalization Select objects to colocalize Determine amount of overlap between objects

Measure Image Area
Occupied

Select objects to measure Measures total area covered by cells and sum of cell perimeters

Measure Object Size Shape Select objects to measure Measure intensities of all cells/nuclei/cytosol

Calculate Math Select features to define Calculate ratio of intensity between nucleus and whole cell

Display Data on Image Select objects and image Number the segmented objects in the Overlaid image

Display Histogram Select features to define Provide histogram representation of intensity –
for normal distribution

Export to Spreadsheet Select features to export Export all data into excel format
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due to cellular complexity and structural heterogeneity present in the scar tissue. This protocol will

define several analysis pipelines for the segmentation of cells in the myocardium and cardiac inter-

stitial space, beginning with the segmentation of nuclei, labeled by DAPI.

6. Change the number of ‘‘workers’’ (see Note below) to 16 in CellProfiler to increase the parallel

processing:
6

a. Open CellProfiler.

b. Select ‘‘Menu > Preferences > Maximum Number of workers: 16’’ and click OK.
7. Begin by loading the required CellProfiler pipeline, by either:
a. Drag and drop the pipeline (Pipeline #1 - 1_Capillary_per_CM_segment.cpproj in the Github

repository) into the left-hand box (Figure 3A-i), below the setup tabs (Methods video S1). See

Note below if using a later version of CellProfiler (i.e., version 4);

b. Or, alternatively, users can build up pipelines to suit their own channel layout and experi-

mental setup, by selecting the ‘‘Adjust modules: +’’ and selecting the modules (Figure 3A-

iii), based on the logic outlined in Table 2 and the segmentation blocks in Figure 4.
8. Open pre-processed image files in CellProfiler and sort them:
a. Select the ‘‘Images’’ tab and drag and drop image files or entire folders into CellProfiler (Fig-

ure 3A-i-ii).

b. Select the ‘‘NamesAndTypes’’ tab (Figure 3B-i), and arrange files by selecting the rules that

apply to the image names (e.g., 1. ‘‘File > Does > Contain regular expression’’ > blue, then 2.

‘‘Name to assign these images’’ > DAPI).

c. Add another image channel by selecting Duplicate this image (Figure 3B-ii).

d. Click ‘‘Update’’, ensuring that the filenames are correctly aligned (Figure 3B-iii) (i.e., image

sets are paired together).
9. Select ‘‘View output settings’’ to change the output directory to desired file location. Input

setting can stay the same, as it is not being used in these pipelines.

10. Select ‘‘Start Test Mode’’ (Figure 3B-iii), this will allow the step-by-step setup of the pipeline for

the user’s images:
a. Select the ‘‘Identify Primary Objects’’ module (Figure 4A-i) and ensure that ‘‘Use advanced

setting’’ is checked Yes (Figure 4A-ii). Then identify the input image as DAPI (or another
STAR Protocols 3, 101097, March 18, 2022



Table 3. CellProfiler troubleshooting for segmentation

Module Problem Solutions

Identify Primary
Objects

No objects detected 1. Adjust Min. and Max. object diameters to
represent magnification (e.g., Lower for 20x
images and higher for 40/63x)
2. Adjust lower threshold bound

Identify Primary
Objects

Background is
being segmented

Increase the lower threshold bound until
only cell/tissue of interest is segmented

Identify Primary
Objects

Lower intensity cells are
not being segmented

1. Decrease the lower threshold bound until
entire objects are detected
2. Lower Threshold correction factor

Identify Primary
Objects

Many small objects
are being segmented
within a single cell/nucleus

Increase the Min. typical diameter of objects

Identify Primary
Objects

Objects are too
separated/split up
(over-segmented)

1. Increase the Min. typical object diameter
2. Increase the size of smoothing filter
3. Increase local maxima distance
4. Increase the threshold correction factor
5. Change the methods to distinguish and
divide clumped objects

Identify Primary
Objects

Objects are merged
together (under-segmented)

1. Decrease the Min. typical object diameter
2. Decrease the size of smoothing filter
3. Decrease local maxima distance
4. Decrease the threshold correction factor
5. Change the methods to distinguish and
divide clumped objects

Identify Primary
Objects

Objects not successfully
segmented, despite changing
settings above

Attempt a 3-class Otsu threshold

Identify Primary
Objects

CM seed (center, within
boundaries) are not detected

1. Decrease the lower threshold bound (from 0.5 to 0.2–3)
2. Change Min. and Max. object diameters
3. Potentially pre-process CMs again in
Fiji to mirror representative images here
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name depending on the naming convention used, select theQuestion mark box to read what

each option does (Figure 4A-iii)). Nuclear segmentation should generally be performed with

an Adaptive, Otsu, Two class threshold:

i. Set ‘‘Object diameter in pixels’’ to relatively stringent low minimum and high maximum

values (e.g., Sizes = 15 and 60 pixels, respectively) (Figure 4A-iv).

ii. Set ‘‘Lower and upper bounds on threshold’’ between flexible values (e.g., 0.001–1.0),

with a flexible (0.8) ‘‘Threshold correction factor’’ (Figure 4A-v).

iii. Set ‘‘Threshold smoothing scale’’ to 1.3488 (Sigma of 1.0) (Figure 4A-v).

iv. Set ‘‘Suppress Local maxima distance’’ and ‘‘Size of smoothing filter’’ to lower than the

minimum object size (e.g., 10 for both) (Figure 4A-vi).

v. Finally, set ‘‘Method to distinguish clumped objects’’ and ‘‘Method to draw dividing lines

between clumped objects’’ to Shape and Shape, respectively (Figure 4A-vi).

b. Click ‘‘Step’’ to observe segmentation quality in the popup window with defined settings

(Figure 4A-vii). If these settings are not appropriate, consult Table 2. and the CellProfiler

Question Mark box for troubleshooting (Figure 4A-iii).

c. Once the segmentation is accurate (Figures 5A and 5B), click ‘‘Step’’ for both ‘‘Overlay Ob-

jects’’ and ‘‘Display Data on image’’, to check segmentation and label objects for down-

stream analysis quality control.

d. Finally, click ‘‘Step’’ on the ‘‘Save Images’’ module to save segmented images as numbered

overlays.

CRITICAL: Segmentation settings should be tested on 10–20 images in the test mode prior
to running finalized analysis, to ensure that they work formany images in a protocol and not

just a small subset.
STAR Protocols 3, 101097, March 18, 2022 7



Figure 3. Home screen view of CellProfiler for setup steps

(A) The Images Tab with, (i) Images module selected for the importation of image files by drag and drop, and

NamesAndTypes module for establishing rules to group images, (ii) Box showing importation of images before and

after import, (iii) Box containing View output settings box to change output directory, Addition box for adding

modules to the pipeline, Start Test Mode button for testing pipeline and segmentation settings, Analyze Images

button for running final pipeline.

(B) The NamesAndTypes tab with, (i) rules to group image by should always use ‘‘File > Does > Contain regular

expression > Rule’’, (ii) Select Duplicate this image to add another channel, (iii) Update button allowing assessment of

channel grouping.
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Note: (1) The number of workers simply signifies the number of images that can be processed

in parallel in open copies of CellProfiler. It is suggested that the numbers of workers should

not exceed the number of physical cores (CPUs) in the computer being used. If using a ma-

chine with low RAM (4/8 GB), and only 8 CPUs, it may be optimal to run with only 4 or 8

workers. With the above settings, depending on the number of images to be run and the
STAR Protocols 3, 101097, March 18, 2022



Figure 4. CellProfiler home screen view with full pipeline

(A) (i) ‘‘IdentifyPrimaryObjects’’ module for nuclei segmentation is highlighted and the following parameters correspond this module, (ii) Checkbox to

use the advanced segmentation settings (check Yes), (iii) CellProfiler help button (Question mark), (iv) Size threshold parameters for the removal of

objects smaller and larger than the diameter limits, (v) Intensity thresholding method and settings for segmentation, (vi) Methods for dividing

segmented objects, (vii) Step button to progress between modules in test mode.
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pipeline complexity, a lot of computer memory may be needed and up to several hours pro-

cessing time (for 1000+ images). Additionally, CellProfiler generates many popup windows

when performing analysis if the ‘‘eye’’ symbol is selected for visualization (Figure 4A-i), so it

is advisable to close other programs before running segmentation tests. In the requisite pipe-

lines, the ‘‘eye’’ symbols are unchecked as this helps speed up processing. (2) The CellProfiler

help button (Question Mark box in Figure 4A-iii), gives detailed information on the function

performed by each line within the module, and often the settings that can be used if objects

are over-segmented (separating objects too much) or under-segmented (not separating

clumped objects enough). In addition, the troubleshooting in Table 2 can be useful for the

segmentation details necessary for ‘‘Identify Primary Objects’’. (3) Each time that a module

setting is changed in ‘‘Start Test Mode’’, the module will have to be rerun.

Segmentation of capillaries

Timing: 5–10 min to set optimal parameters and �5–10 s to analyze each file with

CellProfiler

11. Remaining in ‘‘Start Test Mode’’ as above:
a. Select the next ‘‘Identify Primary Objects’’ module, with an Adaptive, Otsu, Two class

threshold:

i. Set ‘‘Object diameter in pixels’’ to relaxed low minimum and high maximum values (e.g.,

Sizes = 20 and 300 pixels, respectively).
STAR Protocols 3, 101097, March 18, 2022 9



Figure 5. Representative examples of nuclei and capillary segmentation

(A and B) CellProfiler output showing representative segmentation of nuclei with box highlighting a zoomed view (B) of the same image. (C) CellProfiler

output showing representative segmentation of capillaries with box highlighting a zoomed view (D) of the same image.
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ii. Set ‘‘Lower and upper bounds on threshold’’ between flexible values (e.g., 0.04–0.9), with

a flexible (0.75) ‘‘Threshold correction factor’’.

iii. Set ‘‘Threshold smoothing scale’’ to 1.3488 (Sigma of 1.0).

iv. Set ‘‘Suppress Local maxima distance’’ and ‘‘Size of smoothing filter’’ to much higher than

the minimum object size (e.g., 100 for both).
AR Protocols 3, 101097, March 18, 2022



Figure 6. Representative example of CM segmentation

(A–D) Segmentation of background mask, (B) expansion of background mask, (C) generation of an image of the

background mask and (D) application of the mask on the processed CM image.
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Figure 6. Continued

(E and F) CellProfiler output showing representative segmentation of ‘seed’ region within CM boundaries, with box

highlighting a zoomed view (F) of the same image.

(G and H) Expansion of the seed region (E) to CM boundaries and removal of the boundary region from the seed (H).
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v. Finally, set ‘‘Method to distinguish clumped objects’’ and ‘‘Method to draw dividing lines

between clumped objects’’ to Intensity and Shape, respectively.

b. Click ‘‘Step’’ to observe segmentation quality in the popup window with defined settings

(Figure 4A-vii). If these settings are not appropriate, consult Table 2. and the CellProfiler

Question Mark box for troubleshooting (Figure 4A-iii).

c. Once the segmentation is accurate (Figures 5C and 5D), click ‘‘Step’’ for both ‘‘Overlay Ob-

jects’’ and ‘‘Display Data on image’’, to check segmentation and label objects for down-

stream analysis quality control.

d. Finally, click ‘‘Step’’ on the ‘‘Save Images’’ module to save segmented images as numbered

overlays.
Segmentation of CMs

Timing: �15 min to set optimal parameters and �20 s to analyze each file with CellProfiler

Given the larger size of CMs, nuclei of most CMs are not captured in 2D images acquired in a single

plane. One common workaround to this problem is to segment CMs individually in images, rather

than using segmented nuclei as a seed region and expanding to cell boundaries labeled with

WGA (Figures 6A–6H).

12. Remaining in ‘‘Start Test Mode’’ as above, and using ‘‘Step’’ to sequentially test modules, first

generate a mask of the blank space in the image (i.e., between myofibers).
a. Select the next ‘‘Identify Primary Objects’’ module, with an Adaptive, Otsu, Two class

threshold (Figure 6A):

i. Set ‘‘Object diameter in pixels’’ to very flexible low minimum and high maximum values

(e.g., Sizes = 30 and 200 pixels, respectively, to capture as much background as possible.

ii. Set ‘‘Lower and upper bounds on threshold’’ to very stringent high values (e.g., 0.98–1.0),

with a stringent (1.0) ‘‘Threshold correction factor’’ to detect solely empty background.

iii. Set ‘‘Threshold smoothing scale’’ to 1.3488 (Sigma of 1.0).

iv. ‘‘Suppress Local maxima distance’’ and ‘‘Size of smoothing filter’’ can be left to be calcu-

lated automatically.

v. Finally, set ‘‘Method to distinguish clumped objects’’ and ‘‘Method to draw dividing lines

between clumped objects’’ to Intensity and Shape, respectively.

b. Click ‘‘Step’’ to observe segmentation quality in the popup window with defined settings.

c. Select ‘‘Expand or Shrink Objects’’ to expand masked objects arbitrarily by a specified num-

ber of 5 pixels (Figure 6B), click ‘‘Step’’.

d. Select ‘‘Convert Objects to Image’’ to provide an image tomask blank space (Figure 6C), click

‘‘Step’’.

e. Select ‘‘Mask Image’’ to generate the blank space mask (Figure 6D), click ‘‘Step’’.
13. Next, it is necessary to segment individual CMs, using theWGA boundaries, to perform a 3-step

segmentation.
a. First, generate a ‘seed’ region which is inside theWGA boundary, selecting the next ‘‘Identify

Primary Objects’’ module, with an Adaptive, Otsu, Two class threshold (Figures 6E and 6F):

i. Set ‘‘Object diameter in pixels’’ to relatively flexible low minimum and high maximum

values (e.g., Sizes = 30–50 and 150–250 pixels, respectively.

ii. Set ‘‘Lower and upper bounds on threshold’’ between relatively stringent values (e.g.,

0.5–0.97), with a stringent (1.0) ‘‘Threshold correction factor’’.

iii. Set ‘‘Threshold smoothing scale’’ to 1.3488 (Sigma of 1.0).
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Figure 7. CellProfiler graphical and statistical outputs

(A) Average statistics from CM area analysis.

(B) Quantification of numbers of capillaries per CM in representative segmented image.

(C) Scatter plot showing 3 independent examples of CM segmented areas against capillary segmented areas.

(D) Histogram showing 3 independent examples of CM segmented areas.
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iv. Set ‘‘Suppress Local maxima distance’’ and ‘‘Size of smoothing filter’’ to lower than the

minimum object size (e.g., 25–30 for both).

v. Finally, set ‘‘Method to distinguish clumped objects’’ and ‘‘Method to draw dividing lines

between clumped objects’’ to Intensity and Shape, respectively.

b. Click ‘‘Step’’ to observe segmentation quality in the popup window with defined settings.

c. Next, selecting the ‘‘Identify Secondary Objects’’ module, expand the segmentation out-

wards from the ‘seed’ region, defined in 14a (Figure 6G). This will work best with anAdaptive,

Otsu, Gradient Watershed:

i. Set ‘‘Lower and upper bounds on threshold’’ between relatively flexible values (e.g., 0.2–

1.0), with a stringent (1.0) ‘‘Threshold correction factor’’

ii. Set ‘‘Threshold smoothing scale’’ to 1.3488 (Sigma of 1.0).

d. Click ‘‘Step’’ to observe segmentation quality in the popup window with defined settings.

e. Lastly, subtract the objects segmented in 14b (larger object) from 14a (smaller object), selecting

the ‘‘Identify Tertiary Objects’’ module, to give the border regions (Figure 6H), click ‘‘Step’’.

f. Once the segmentation is accurate, click ‘‘Step’’ for both ‘‘Overlay Objects’’ and ‘‘Display

Data on image’’, to check segmentation and label objects for downstream analysis quality

control.
14. To quantify the area and sizes of CMs (for hypertrophy studies), or determine the numbers of

capillaries present per CM (for rarefaction studies), the following quantification modules can

be used (Figures 7A–7D):
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a. Select the ‘‘Measure Object Size Shape’’ module, to quantify geometric parameters of

segmented capillaries (from 12b) and cardiomyocytes (from 14b) (Figure 7A), click ‘‘Step’’.

b. Select the ‘‘Measure Image Area Occupied’’ module, to quantify geometric parameters of

segmented capillaries (from 12b) and cardiomyocytes (from 14b), click ‘‘Step’’.

c. Select the ‘‘Calculate Math’’ module, to quantify the ratio of capillaries to cardiomyocytes

(Figure 7B) (outputs to ‘‘Image’’ .csv file), click ‘‘Step’’.

d. Use the ‘‘Display Density Plot’’ module, to show the shared distribution of capillary and car-

diomyocyte areas (Figure 7C), click ‘‘Step’’.

e. Select the ‘‘Display Histogram’’ module, to show the distribution of cardiomyocyte areas

(Figure 7D), click ‘‘Step’’.
15. Finally, click ‘‘Step’’ on the ‘‘Save Images’’ module to save segmented images as numbered

overlays.

16. Once all segmentation steps are optimized, the pipeline is ready to be run, select ‘‘Analyse Im-

ages’’.

17. Once the run is complete, data, in .csv file format, and segmentation images, in .tiff file format,

will be available in the output directory for downstream processing.

Note: (1) Once ‘‘Analyze Images’’ is clicked to run the pipeline, there is often a delay before

the analysis starts. Depending on the specification of the computer used and the number of

images analyzed, this may vary from 1–10 min. At this point, it is advisable to be patient

and wait for analysis to begin. If 10 minutes has passed, there may be an error and CellProfiler

may need to be restarted. (2) Following the analysis of the users’ own images, it is advisable to

cross check all of the segmentation example .tiff files in the output directory for accurate seg-

mentation and quantification. Due to the inherent variability in the acquisition of microscopy

images, the settings may not be applicable for every image in the image set, and as such, it

may be necessary to run separate analyses in CellProfiler, with changed settings, on those im-

ages not properly segmented. (3) There are additional quantification modules that may be

useful for determining features of interest, such as the proximity of CMs to one another (‘‘Mea-

sure Object Neighbors’’) or internal features of myocytes (‘‘Measure Texture’’ or ‘‘Measure

Granularity’’). However, these may only be useful for a specific purpose. For the more stan-

dardized cardiac phenotype indexing, CM hypertrophy and capillary rarefaction should be

sufficient. (4) Depending on the number of images to be run and the pipeline complexity,

this may require a lot of computer memory, and up to several hours (for 1000+ images).

Pipeline #2 – Quantify number of immune cells per cardiomyocyte

Segmentation of immune cells

Timing: 5–10 min to set optimal parameters and �5–10 s to analyze each file with

CellProfiler

The irregular shape and projections of invading immune cells (CD45+) in the cardiac interstitium

make them inherently challenging to segment. Here, we describe an additional CellProfiler pre-pro-

cessing step to clean the edges and boundaries of the CD45+ cells analyzed.

18. Begin by loading the required CellProfiler pipeline, by either:
a. Drag and drop the pipeline (Pipeline #2 - 2_CD45_per_CM_segment.cpproj in the Github

repository) into the left-hand box (Figure 3A-i), below the setup tabs.

b. Or, alternatively, users can build up pipelines to suit their own channel layout and experi-

mental setup, by selecting the ‘‘Adjust modules: +’’ and selecting the modules (Figure 3A-

iii), based on the logic outlined in Table 2 and the segmentation blocks in Figure 4.
19. Open pre-processed image files in CellProfiler and sort them:
a. Select the ‘‘Images’’ tab and drag and drop image files or entire folders into CellProfiler (Fig-

ure 3A-i-ii).
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Figure 8. Representative examples of immune cell processing and segmentation

(A) CellProfiler output showing immune cell image before and after smoothing.

(B and C) CellProfiler output showing representative segmentation of smoothed immune cells with box highlighting a zoomed view (C) of the same

image.
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b. Select the ‘‘NamesAndTypes’’ tab (Figure 3B-i), and arrange files by selecting the rules that

apply to the image names (e.g., 1. ‘‘File > Does > Contain regular expression’’ > blue, then 2.

‘‘Name to assign these images’’ > DAPI).

c. Add another image channel by selecting Duplicate this image (Figure 3B-ii).

d. Click ‘‘Update’’, ensuring that the file names are correctly aligned (Figure 3B-iii) (i.e., channels

from each image set are paired up).
20. Select ‘‘View output settings’’ to change the output directory to desired file location. Input

setting can stay the same, as it is not being used in these pipelines.

21. Enter ‘‘Start Test Mode’’ as above.

22. Stepwise, progress through the nuclei segmentation steps, from the first ‘‘Identify Primary Ob-

jects’’ module, as above (Step 10).

23. After running the first ‘‘Save Images’’ module, proceed forward with CD45+ cell segmentation

below:
a. Select ‘‘Smooth’’ module to homogenize the appearance of CD45+ cells, using the function

Smooth keeping edges, and automatically calculating the Artifact diameter. Keep the Edge

Intensity difference at 0.1 (Figure 8A), click ‘‘Step’’.

b. Segmentation of CD45+ cells is then performed by selecting the ‘‘Identify Primary Objects’’

module, using an Adaptive, Otsu, Two class threshold:

i. Set ‘‘Object diameter in pixels’’ to relatively stringent low minimum and high maximum

values (e.g., Sizes = 20 and 100 pixels, respectively.

ii. Set ‘‘Lower and upper bounds on threshold’’ between flexible values (e.g., 0.005–1.0),

with a flexible (0.75) ‘‘Threshold correction factor’’.

iii. Set ‘‘Threshold smoothing scale’’ to 1.3488 (Sigma of 1.0).

iv. Set ‘‘Suppress Local maxima distance’’ and ‘‘Size of smoothing filter’’ to lower than the

minimum object size (e.g., 20 for both).

v. Finally, set ‘‘Method to distinguish clumped objects’’ and ‘‘Method to draw dividing lines

between clumped objects’’ to Shape and Shape, respectively.

c. Click ‘‘Step’’ to observe segmentation quality in the popup window with defined settings.

d. Once the segmentation is accurate (Figures 8B and 8C), click step for both ‘‘Overlay Objects’’

and ‘‘Display Data on image’’ modules, to check segmentation and label objects for
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Figure 9. Comparison of manual and automated segmentation methods for immune cell quantification

(A and B) Manual quantification of immune cells using Fiji compared with the automated quantification (B) by

CellProfiler. The red box identifies a region of the image, where objects were not segmented due to them being below

the intensity threshold. This highlights the necessity for correct intensity thresholding across many images.
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downstream analysis quality control, such as with a comparison against manual CD45+ cell

quantification with Fiji (Figure 9).
24. Finally, click ‘‘Step’’ on the ‘‘Save Images’’ module to save segmented images as numbered

overlays.

25. Stepwise, progress through the CM segmentation steps, as above (steps 13–16).

26. Once all segmentation steps are optimized, the pipeline is ready to be run, select ‘‘Analyse Im-

ages’’.

27. Once the run is complete, data, in .csv file format, and segmentation images, in .tiff file format,

will be available in the output directory for downstream processing.

Pipeline #3 – Quantify number of proliferating fibroblasts

Segmentation and quantitation of proliferating CFs

Timing: 5–10 min to set optimal parameters and �5–10 s to analyze each file with

CellProfiler

28. Begin by loading the required CellProfiler pipeline, by either:
a. Drag and drop the pipeline (Pipeline #3 - 3_EdU_FB_segment.cpproj in the Github reposi-

tory) into the left-hand box (Figure 3A-i), below the setup tabs.

b. Or, alternatively, users can build up pipelines to suit their own channel layout and experi-

mental setup, by selecting the ‘‘Adjust modules: +’’ and selecting the modules (Figure 3A-

iii), based on the logic outlined in Table 2 and the segmentation blocks in Figure 4.
29. Open pre-processed image files in CellProfiler and sort them:
a. Select the ‘‘Images’’ tab and drag and drop image files or entire folders into CellProfiler (Fig-

ure 3A-i-ii).

b. Select the ‘‘NamesAndTypes’’ tab (Figure 3B-i), and arrange files by selecting the rules that

apply to the image names (e.g., 1. ‘‘File > Does > Contain regular expression’’ > blue, then 2.

‘‘Name to assign these images’’ > DAPI).

c. Add another image channel by selecting Duplicate this image (Figure 3B-ii).

d. Click ‘‘Update’’, ensuring that the filenames are correctly aligned (Figure 3B-iii) (i.e., image

sets are paired together).
30. Select ‘‘View output settings’’ to change the output directory to desired file location. Input

setting can stay the same, as it is not being used in these pipelines.

31. Enter ‘‘Start Test Mode’’ as above.
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32. Stepwise, progress through the nuclei segmentation steps, from the first ‘‘Identify Primary Ob-

jects’’ module, as above (Step 10).

33. After running the first ‘‘Save Images’’module, proceed forward with CF TdT+ cell segmentation

below:
a. Select ‘‘Identify Primary Objects’’ module, segment with an Adaptive, Otsu, Three class

threshold:

i. Set ‘‘Object diameter in pixels’’ to relatively stringent low minimum and high maximum

values (e.g., Sizes = 30 and 120 pixels, respectively.

ii. Set ‘‘Lower and upper bounds on threshold’’ between flexible values (e.g., 0.05–1.0), with

a flexible (0.75) ‘‘Threshold correction factor’’.

iii. Set ‘‘Threshold smoothing scale’’ to 1.3488 (Sigma of 1.0).

iv. ‘‘Assign pixels in the middle intensity class to the: Background’’.

v. Set ‘‘Suppress Local maxima distance’’ and ‘‘Size of smoothing filter’’ to higher than the

minimum object size (e.g., 40 for both).

vi. Finally, set ‘‘Method to distinguish clumped objects’’ and ‘‘Method to draw dividing lines

between clumped objects’’ to Intensity and Shape, respectively.

b. Click ‘‘Step’’ to observe segmentation quality in the popup window with defined settings.

c. Once the segmentation is accurate (Figures 10A–10D), click ‘‘Step’’ for both ‘‘Overlay Ob-

jects’’ and ‘‘Display Data on image’’ modules, to check segmentation and label objects for

downstream analysis quality control.
34. Segmenting EdU+ nuclei requires the same process as Step 10a-c (Segmentation of nuclei):
a. Select the ‘‘Identify Primary Objects’’module and segment with anAdaptive, Otsu, Two class

threshold:

i. Set ‘‘Object diameter in pixels’’ to relatively stringent low minimum and high maximum

values (e.g., Sizes = 15 and 60–80 pixels, respectively).

ii. Set ‘‘Lower and upper bounds on threshold’’ between flexible values (e.g., 0.001–1.0),

with a flexible (0.8) ‘‘Threshold correction factor’’.

iii. Set ‘‘Threshold smoothing scale’’ to 1.3488 (Sigma of 1.0).

iv. Set ‘‘Suppress Local maxima distance’’ and ‘‘Size of smoothing filter’’ to lower than the

minimum object size (e.g., 10 for both).

v. Finally, set ‘‘Method to distinguish clumped objects’’ and ‘‘Method to draw dividing lines

between clumped objects’’ to Shape and Shape, respectively.

b. Click ‘‘Step’’ to observe segmentation quality in the popup window with our defined settings.

c. Once the segmentation is accurate, click ‘‘Step’’ and perform both ‘‘Overlay Objects’’ and

‘‘Display Data on image’’, to quality check segmentation and label objects for downstream

analysis quality control.
35. To first quantitate the numbers of proliferating CFs, select the ‘‘Measure colocalization’’module

and select EdU and CF images for comparison, and compare with the threshold set at 10% of the

maximum intensity across the entire image. Check Yes for ‘‘Run all metrics’’ option.

36. Additionally, it is necessary to quantify overlapping segmented CFs with segmented EdU+

nuclei. To do this, the segmented objects must be related to one another (i.e., EdU+ nuclei

that lie within segmented CF areas) and are then re-counted (Figures 11A and 11B):
a. Firstly, select the ‘‘Relate Objects’’module, with segmented CFs as the ‘‘Parent objects’’ and

segmented EdU+ nuclei as the ‘‘Child objects’’, click ‘‘Step’’.

b. Save the children with parents as a new object set (check Yes).

c. Select ‘‘Convert objects to image’’ to save the related EdU+ CFs (double positive) objects as a

new Colour image, click ‘‘Step’’.

d. Once the segmentation is accurate, click ‘‘Step’’ for both ‘‘Overlay Objects’’ and ‘‘Display

Data on image’’, to check segmentation and label objects for downstream analysis quality

control.
37. Lastly, quantify parameters relevant to amounts of double positivity and CF sizes.
a. Select the ‘‘Measure Object Size Shape’’ module, to quantify geometric parameters of

segmented CFs, click ‘‘Step’’.
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Figure 10. Representative examples of CF segmentation at different stages after Myocardial Infarction

(A and B) CellProfiler output showing representative segmentation of CFs from the border zone 1-day post-MI with box highlighting a zoomed view (B)

of the same image.

(C and D) CellProfiler output showing representative segmentation of CFs from the mid-infarct region 3-days post-MI with box highlighting a zoomed

view (D) of the same image.
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b. Select the ‘‘Measure Image Area Occupied’’ module, to quantify geometric parameters of

segmented CFs, click ‘‘Step’’.

c. Select the ‘‘Calculate Math’’module, to quantify the percentage of proliferating CFs (outputs

to ‘‘Image’’ .csv file), click ‘‘Step’’.
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Figure 11. Example relating segmented proliferating nuclei with segmented CFs

(A and B) CellProfiler example of the related objects process and the quantification (B) showing the percentage of

active proliferating CFs of the total segmented CFs.
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38. Finally, click ‘‘Step’’ on the ‘‘Save Images’’ module to save segmented images as numbered

overlays.

39. Once all segmentation steps are optimized, the pipeline is ready to be run, select ‘‘Analyse Im-

ages’’.

40. Once the run is complete, data, in .csv file format, and segmentation images, in .tiff file format,

will be available in the output directory for downstream processing.

Note: The quantification of proliferating CFs was performed here; however, it is conceivable

also to quantify total proliferation or other cell-type proliferation by modifying the modules

within the pipeline as necessary.
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Pipeline #4 – Quantify number of apoptotic cells

Segmentation of apoptotic nuclei

Timing: 5–10 min to set optimal parameters and �5–10 s to analyze each file with

CellProfiler

TUNEL staining is used to detect DNA breaks formed during the final phase of apoptosis, when DNA

fragmentation takes place.

41. Enter ‘‘Start Test Mode’’ as above.

42. Stepwise, progress through the nuclei segmentation steps, from the first ‘‘Identify Primary Ob-

jects’’ module, as above (Step 10).

43. After running the first ‘‘Save Images’’module, proceed forward with TUNEL+ cell segmentation

below.

44. Segmenting TUNEL+ nuclei require the same process as Step 10a-c (Segmentation of nuclei):
20
a. Select the ‘‘Identify Primary Objects’’ module. Nuclear segmentation should generally be

performed with an Adaptive, Otsu, Two class threshold:

i. Set ‘‘Object diameter in pixels’’ to relatively stringent low minimum and high maximum

values (e.g., Sizes = 15 and 60–80 pixels, respectively).

ii. Set ‘‘Lower and upper bounds on threshold’’ between flexible values (e.g., 0.001–1.0),

with a flexible (0.8) ‘‘Threshold correction factor’’.

iii. Set ‘‘Threshold smoothing scale’’ to 1.3488 (Sigma of 1.0).

iv. Set ‘‘Suppress Local maxima distance’’ and ‘‘Size of smoothing filter’’ to lower than the

minimum object size (e.g., 10 for both).

v. Finally, set ‘‘Method to distinguish clumped objects’’ and ‘‘Method to draw dividing lines

between clumped objects’’ to Shape and Shape, respectively.

b. Click ‘‘Step’’ to observe segmentation quality in the popup window with our defined settings.

If these settings are not appropriate, consult Table 2. and the CellProfilerQuestion Mark box

for troubleshooting.

c. Once the segmentation is accurate, click ‘‘Step’’ for both ‘‘Overlay Objects’’ and ‘‘Display

Data on image’’, to check segmentation and label objects for downstream analysis quality

control.
45. Click ‘‘Step’’ on the ‘‘Save Images’’ module to save segmented images as numbered overlays.

46. Additionally, it is necessary to quantify overlapping segmented nuclei with segmented TUNEL+

nuclei. To do this, the segmented objects must be related to one another (i.e., TUNEL+ nuclei

that lie within segmented nuclear areas) and are then re-counted:
a. Firstly, select the ‘‘Relate Objects’’ module, with segmented nuclei as the ‘‘Parent objects’’

and segmented TUNEL+ nuclei as the ‘‘Child objects’’, click ‘‘Step’’.

b. Save the children with parents as a new object set (check Yes).

c. Select ‘‘Convert objects to image’’ to save the related TUNEL+ DAPI+ (double positive) ob-

jects as a new Colour image, click ‘‘Step’’.

d. Once the segmentation is accurate, click ‘‘Step’’ for both ‘‘Overlay Objects’’ and ‘‘Display

Data on image’’, to check segmentation and label objects for downstream analysis quality

control.
47. Once all segmentation steps are optimized, the pipeline is ready to be run, select ‘‘Analyse Im-

ages’’.

48. Once the run is complete, data, in .csv file format, and segmentation images, in .tiff file format,

will be available in the output directory for downstream processing.

Note: Segmentation of apoptotic nuclei can be performed for any cell-type specific

segmented objects (e.g., CFs, CMs, IB4+ capillaries or CD45+ cells), as performed in Step

46, via the ‘‘Relate Objects’’ module.
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EXPECTED OUTCOMES

Studying cardiac parameters in infarcted mouse hearts is technically challenging owing to the

cellular complexity and structural heterogeneity present in the scar tissue. Our protocol overcomes

the challenges associated with manual handling and user-based decisions, and therefore improves

the reliability of morphological comparisons. Thus, this semi-automated computational approach

improves objectivity by minimizing bias associated with manual image processing and quantifica-

tion. With this protocol, cardiac parameters can be reliably quantified in infarcted mouse hearts

and in different anatomical locations, considerably faster than manual assessment. Additionally, im-

mune cells can be differentially labeled to discernmonocyte andmacrophage sub-populations (e.g.,

M1 andM2), and quantified using this pipeline. Data generated using this protocol has recently been

published (Janbandhu et al., 2021). While we have used this protocol for studies mainly in infarcted

mouse hearts, this pipeline can easily be applied to the other tissue types.
QUANTIFICATION AND STATISTICAL ANALYSIS

The output file (.csv) can be imported into most of the commonly used data analysis software such as

Excel and GraphPad Prism. Output files contain many redundant columns, unnecessary for analysis.

Generally, the columns relating to cell counts, shape and size, and other morphological parameters

are the only necessary columns (see the annotated .xlsx file to determine which columns are of use

for analysis). Statistical analysis can be performed on the absolute or relative measurements as

required. Objects not segmented properly can be determined from the overlay output images,

these should subsequently be excluded from the analysis.
LIMITATIONS

This protocol is optimized for quantifying parameters essential for the functioning of the cardiac in-

terstitium in healthy and infarcted murine hearts. This represents an automated pipeline to quickly

and quantitatively measure the cell-type, size and distribution in the murine myocardium and inter-

stitial regions from 2D fluorescent images. As with many image analysis processes, automated seg-

mentation of tissue requires a balance between over- and under-segmentation. Due to atypical cell

morphologies in vivo, it may not be possible to capture every single cell in an image field of view with

hard size and intensity thresholding methods, as used here. Inherently, when segmenting immune

cells and fibroblasts in tissues, which are typically amorphous cell-types crowded into the interstitial

space, there will be cases of imperfections in segmentation (cells split or clumped when they should

not be) which are unavoidable. Given the nature of automation, however, errors will be identical be-

tween images; as opposed to those from manual segmentation methods, which are open to inves-

tigator-bias. This pipeline aims to reduce segmentation and quantification errors to within 5% of

those seen with a manual segmentation method.
TROUBLESHOOTING

This table outlines some potential solutions for segmentation problems that can arise in CellProfiler.

Solutions are sometimes numbered in order of priority, so that users can trial each adjustment in test

mode. Additionally, the question mark box next to the parameter has useful tips for segmentation.
Problem 1

Channels are split incorrectly by Fiji Macros (steps 2–5)
Potential solution

Input the raw image into Fiji and run the ‘‘Image > Color > Split Channels’’ function. Check the chan-

nel number given to each image name in Fiji (e.g., C1 = Green Channel) (See Figure 1). If this does

not match up with the name given to the channel in Macros, alter the color to match the number. It

may be useful to compare Macros #1 or 2, to determine how the macro layout relates to channel

order.
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Problem 2

Poor segmentation of cells from injured zones of the heart (steps 12–17 and 33–38)

Potential solution

Injured regions show drastically different cell morphology and distribution, due to scarring, as such,

these regions may not always segment well. Settings may need to be adjusted to segment images

from within the infarcted zone, and these images run separately from non-injured myocardium.

Problem 3

Segmentation of cardiomyocytes is incomplete (steps 12–17)

Potential solution

This may occur if cardiomyocyte images have been ‘over-enhanced’ in the pre-processing steps and

is easily corrected by modifying the pixel saturation value in Macro #1,2 and 4. If cardiomyocyte

boundaries are too dark, lower this value. If they are not dark enough, increase this value.

Problem 4

Segmentation of individual objects is still unsatisfactory (under- or over-segmented) due to poor

input image quality (relevant to each pipeline - steps 6–50)

Potential solution

It is possible that, if the initial image quality is sub-optimal, CellProfiler will be unable to segment

single objects properly. For instance, discrimination between a group of clumped objects may be

impossible to resolve due to high background or blur in the image (from widefield fluorescence im-

ages). This may be unresolvable for segmentation of individual objects; however, data may be pre-

sented as a total area occupied by objects, thus overcoming the issue of object segmentation as the

image segmentation should still be able to discern gross background from foreground based on in-

tensity values.

Problem 5

Very slow processing of images or pipeline does not seem to be progressing (steps 16, 26, 39 and

50)

Potential solution

Occasionally, after ‘‘Analyze Images’’ is clicked, CellProfiler does not respond. This may be due to

the visualization being left on (‘‘eye’’ symbol checked), too many images being processed and/or

another fault. In this case, there is no benefit to waiting for the pipeline to respond, so, providing

the pipeline is saved, the user should just close CellProfiler and reopen it.

RESOURCE AVAILABILITY

Lead contact

Further information and requests for resources and reagents should be directed to and will be ful-

filled by the Lead Contact, Richard P. Harvey (r.harvey@victorchang.edu.au).

Materials availability

This study did not generate new unique reagents.

Data and code availability

Janbandhu et al. (2021) contains representative datasets as would typically be obtained using this

protocol. In addition, images, Macros and analysis pipelines will be available in the Victor Chang

Cardiac Research Institute Github repository: https://github.com/VCCRI/Cardiac-Image-Analysis.

git.
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SUPPLEMENTAL INFORMATION
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